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What is the Internet? 

The Internet is a collection of information stored in computers physically located throughout the 
world. It connects more than 3.2 million mainframes to each other, but each one has its own job to 
do. The World W ide Web (WWW) was created by particle physicists working at CERN, and 
was a system of storing information in a format that had the addresses of other sites with similar 
information saved with it. Through W W W , much of the information on the Internet is organized 
onto pages. You’ll bring one page to your computer screen, discover its contents, and have the 
option of going to more pages of information. 

NCSA Mosaic 

A bunch of computer science students and the University of Illinois’ National Center for 
Supercomputing created a program called Mosaic. Mosaic took Web files, complete with links, 
and displayed them in a graphical window. Links are underlined text, called hypertext, that takes 
you to another page. Mosaic emphasized the actual information, but not the source. 

Takixw a SteD Further - the NetscaDe Navbator 

Netscape picks up where NCSA Mosaic left off. It installs easily, works well over a 
conventional modem connection, and is supported by a professional software company. Bugs get 
fixed and features get added in response to customers (instead of NCSA’s method of updates 
which responded to academic pressures). It uses most standard Internet services and mimics many 
of the UNIX-based text programs that most people find confusing. 

Netscape truly integrates the hypertext-based W W W  with the older, conventional Internet formats 
that haven’t yet been or will never be, converted to the Web’s HTML (HyperText Markup 
Language) format. Netscape knows what to expect from older Internet services and assigns 
some hypertext links within them automatically. 

Caution: 

Although Netscape provides some security for information it reads and sends out, the security is 
still very limited. For example, Netscape will allow you to bring up a form to send e-mail to 
Internet e-mail addresses. But there is no verification of the sender’s e-mail address. 
The sender can type in any e-mail address. Similarly, there are problems with sending and 
viewing secure information on W W W . 
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To find a single WWW page in a world of electronic pages, you need to know its URL, short for 
Uniform Resource Locator. Every page has a unique URL just like every person has a unique 
palm print. (Arguments persist as to which is more cryptic.) 

Netscape gives you two options of typing in the URL: 

1) type a URL directly into the location text field 

r 6 File Edit Uiew Go Bookmarks Options Directory Help 
:m Netscape: PEP-l I/BABAR Database Information _I__“- 

2;: IF,Q~r,l EQl ,ZdI ,gsI E 1 gt p$ 1 E$ 1 

.LOOatiOn: http://www.slac.stanford.edu/accel/pepii/db.html 

2) or pull down File menu to Open Location, 
type desired URL in the Open Location dialog box 

r & File Edit Uiew Go Bookmarks Options Directory Hel 
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How to read a Uniform Resource Locator (URL) 

http://llama.ucsd.edu/pub/webfiles~index.html 

6 
0 First is the protocol (language) that the site uses. 

Next is the location or host name of the computer that stores the resource. 

0 Now you indicate the directory structure where the resource is located. 

0 Findls, here’s the name of the WQb page or name of the file that links the resource. 

For example, to use the Gopher menus at pccat.alog.peed.com: 
gopher://pccrtalog.pmod.co~ 

To enter the anonymous FTP site at wuarchive.wustl.edu: 
ttp: / /wuarchlvo .wurtl.mdu 

Protocol abbreviations 
P-l wh8VS It for? 
http: I/ Hypertext Transfer Protocol-linking Keb pages 

ttp: I/ File Transfer Protocol-accessing anorqmous mP sites, 
and Web pages at older sites 

gopher:// Gopher protocol-accessing Gopher menus 

tolnrt:/l Starts a Telnet session and opens a Telnet window to run older, 
text-based Internet programs 

milto: Opens Netscape’s Send Mail dialog box to send e-mail 

news: Opens a UseNet newsgroup to link posted articles 

Domain abbreviations 
odu Educational institutions 

corn Commercial businesses 

eov The VS. government 

mil The U.S. military 

not Network or Internet !&nice Pro\jders 

erg Other organizations 

Figure fram ‘Using Netscape’ by 
Warren Ernst, QUE Corporation. 
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Frequently-used URL’s for PEP-II and BABAR 

PEP-II/BABAR Project Database 

http://www.slac.stanford.edu/accel/pepii/db.html 

PEP-II Accelerator Home Page 

http://www.slac.stanford.edu/accel/pepii/home.html 

FTP PEPII-Server 

ftp://pepii-server,slac.stanford.edu/ 

SLAC BABAR Detector Home Page 

http://www.slac.stanford.edu/BF/doc/ww~~/bfHome.html 

SLAC Home Page 

http://www.slac.stanford.edu/FIND/slac.html 

Stanford University Libraries & Academic Information Resources Home Page 

http://www-sul.stanford.edu:8000/ 

Stanford University User Server 

http://www-leland.stanford.edu/ 

Welcome to Netscape 

http://home.mcom.com/home/welcome.html 

The Netscape Online Handbook 

http://home.netscape.com/eng/mozilla/l.l/handbook/ 
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Netscape Commands 

In addition to hypertext links in the content area of the page, you can also access links using 
Netscape buttons and menu items. Many of the links controlled by buttons and menu items bring 
pages you have viewed at least once before. Button links are particularly useful for going back and 
forth among recently viewed pages. 

Menu item links directly access a wide range of pages such as a history list of pages you have 
viewed or a bookmark list of pages you (or others) have personally selected as noteworthy. Here 
is a list of useful Netscape commands and their actions: 

Selection 

Bookmarks Add Bookmark Mark a site so you can visit it later 

Directory Go to Newsgroups Join a newsgroup or review 
newsgroup articles 

File Exit Exit Netscape 

File 

File 

File 

File 

Go 

Options 

Options 

Options 

Options 

Options 

View 

Mail Document 

Open File 

Print 

Save As 

View History 

Auto Load Images 

Preferences 

Show Directory Buttons 

Show Security Colorbar 

Show Toolbar 

Source 

Create e-mail (see page 1) 

Load a saved Web page from disk 

Print the current page 

Save the current page to disk 

See the list of places where 
you’ve been this session 

Turn graphics off/on 

Configure Netscape (see page 16) 

Turn directory buttons off/on 

Turn security colorbars off/on 

Turn the toolbar off/on 

View the HTML file for the 
current page 
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Buttons 

What do the buttons do? 

Back goes back to the previous Web page. 

Forward displays the next Web page in the history list. 

Home displays your home page. 

Reload reloads and redisplays the current page. 

Images displays inline images with the current page 
(if they don’t automatically load into view). 

Open manually retrieves a new Web page and displays it 
(you have to type an address). 

Find searches for a word or phrase within the current 
Web page. 

Stop halts the transfer of Web pages from the Internet into 
the content area. 

How can I save more screen suace? 

You can save more space by hiding your toolbar, directory buttons, and/or the location text field. 

Menu 

Options 

Selection Action 

Show toolbar Show/hide toolbar 
Show Directory Buttons Show/hide buttons 
Show Location Show/hide location 
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How can I customize the buttons? 

You can change the appearance of the buttons at the top of the screen. Make them have just 
pictures, just text or both. See figure below to save more screen space. 

Pictures 8; Text 
r 

6 File Edit Ui ew Go Bookmarks Options Directory Help 
! NetsCaDe: PEP-l I/BABAR Database Information SZZZ 

& File Edit Uiew Go Bookmarks Options Directory Help 
32 Netscape: PEP-II/BABAR Database Information _;=; 

Text 
r 

6 File Edit Uiew Go Bookmarks Options Directory Help 
ED Netscape: PEP-l l /BABAR Database Information _I_ 

Back 1 Forwardl Home 1 +&load 1 Images 1 Open 1 Print 1 Find 1 Stop 1 

Here is. how to customize buttons: 

Menu Selection 

Options Preference 
(under W indow and Link Styles) 

Action 

change appearance 
of the buttons 

CODV text from Web DaPes to your Clipboard 

Netscape allows you to Select and Copy text right off the Web page: 

1) Move the mouse pointer to the beginning of the text you wish to copy and select the text. 

2) Choose Copy from the Edit menu to copy the text, then Paste into your document. 
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Bookmarks 

You can save a page with Netscape’s bookmark command just as you can save a page in a book 
with a regular bookmark. 

To add a bookmark: 

Menu Selection 

Bookmarks Add Bookmark 

Action 

Adds your favorite pages to the 
bottom of the Bookmarks menu 

Netscape makes jumpin g to a page marked with a bookmark easy. There are two methods of 
viewing a bookmarked page: 

Menu Selection Action 

Bookmarks pull down to 
desired bookmark 

brings up bookmarked page 

Bookmarks View Bookmarks 
(select desired 
bookmark then 
click Go to) 

brings up bookmarked page 

Accessing a page from the Bookmarks Menu is generally more convenient, but it can only display 
as many bookmarks as you have screen space. 

The Bookmark List dialog box, (brought up by View Bookmarks on the Bookmark Menu) has a 
scrollable and searchable list that provides access to hundreds of bookmarks at once, and it even 
provides a Find command to find that hard-to-spot bookmark in a large list (See figure on next 
page). 
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$ File Edit View Go Bookmarks Options Directory Help 

i[7D Bookmark list i 

?EP-IIIBABAR Database Information 
SLAC I 

PEP-II Accclcrator Home Page 

FTP PEP I I-SQrVQr 

FTP LBL (Rimmer) 

SL AC Home Page 

SLAC Controls Dcptartmrnt HOmQ 

IADBG WQlCOmQ 

Stanford 
Stanford University LibrariQS &. 

lttp : / /homQ .mcom .com /homQ /wQlCOmQ .h 

00 
(Find:) netscape 1 

rlenu Adds Alter: tna ot List - 

Menu Starts With : Entire List w 

[New bookmark ) ( New Herder I] [New Divider ) 

Name : Wclcomc to NQtscapc I 

Location : htto://hOmQ.mCOm.cOm/hOmQ/WQlCOmQ.htr~ 

Last Visited : Tut, Jun 20, 1995 

Added On : Sat, Mar 14, 1925 

DQscription : 

y-) [Option+) [Copy] [lcmor,) 
E Ccc - 

Figure of Bookmark List Dialog Box 

Some buttons on the Bookmark List dialog box 

Go To--With desired bookmark highlighted click this button to jump to bookmarked page 

Remove Item--Removes highlighted bookmark 

New Divider--Puts a dividing line in your bookmark List dialog box, you can move the divider 
with the arrow buttons 

New Header--Type in a heading to separate different bookmarks, you can move the heading with 
the arrow buttons 

Export--Saves your list of bookmarks to your hard drive or to a disk 

Import--Imports Netscape Bookmark lists, as well as Mosaic Hotlists 
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File Transfer Protocol (FTP) 

PEP-WBABAR shared files & drawings, together with general information and software for your 
computer is available for you to copy from the Internet via FTP, a File Transfer Protocol. 
Netscape transforms anonymous FTP into a simple way to get a copy of the files you want from a 
server to your desktop computer. 

How to use Anonvmous FTP with Netscane 

1) Choose Open Location from the File menu or click in the location field. 

2) Add “ftp://” to the beginning and a ‘7” at the end of the FI’P site’s address 
(which creates the URL: ftp:Npepii-server.slac.stanford.edu/ in the example below) 
Click the Open button or press the Enter key. 

’ 6 File Edit Uiew Go Bookmarks Options Directory Hel 

I Location: ftp:I/pepii-server.slac.stanford.edu/ 

Handbook 1 Net Search 1 Net DirectoryI ‘,.w Hhat%N!w?l What’sCool? 

Currentdirectoryis~ .~ ,,’ 1 Currentdirectoryis~ .~ ,,’ 1 

IOeloome to PEPII-SERPER.SLAC.STM?FORD.EDU, IOeloome to PEPII-SERPER.SLAC.STM?FORD.EDU, _.j, _.j, 

You are either logged in as vser ftp or Axtymous. ’ 0 You are either logged in as vser ftp or Aonymous. ’ 0 

This PTP Server currently allows 10 simultwwous FTP sessions. This PTP Server currently allows 10 simultwwous FTP sessions. 
Problems with your PTP ssssionto this machine should be Problems with your PTP session to this machine should be rep report 
to johnw@slac.stanford.edu immediately. ' to johnw@slac.stanford.edu immediately. ' ,' ,' 
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Subdirectory Jumps to a new subdirectory. 

I3 
Document Transfers an HTML, text. or PostScript file to your 

computer via FTP. 

ri 
File Transfers a generic file to your computer via FW. 

There are frequently compressed computer programs, 
and if Netscape can determine the type of file it is, it 
will list it along with other file information in the 
content area. 

Executable Tranrfen an uncomprerred program that will probabb 
run on your computer without modification via FIT’. 

To Navigate through an FTP Site: 

l To jump down a directory level to a subdirectory, click on the folder icon or the hypertext. 

l To jump up a directory level, 
click on the hypertext that reads Up to higher level directory. 

To Download a File from an FTP Site: 
(For Macintosh users, FTP downloads with Fetch is preferred, see page 12) 

1) To download a file, click on the file’s icon or the hypertext filename 

Caution: Big files (> a few hundred kb) take a long time to be transferred across the network 
and appear on your screen. Please be aware of the size of the file you are 
viewing or downloading. Click on the Stop button if you want to stop the transfer. 

2) To start the file transfer, click Save As in the File menu. Netscape will ask you to specify a 
new filename. 

If the file type of the file you are downloading is not among those which automatically run a 
helper application, Netscape displays dialog box saying ‘This application has not been 
configured to handle documents of this type’. 
l You can configure Netscape to run a helper application on this file by clicking on 

the Pick application button to specify the program. 

l Click Cancel Transfer if you want to stop the transfer. 

For Macintosh users- 
. If you click on the Save document button. The file is then saved onto the hard 

disk without an icon identifying what program created it. You will have to open the 
file from within the application. 

For Macintosh users who have Stuffit Expander installed, Netscape will 
send the compressed Mac file to Stuffit Expander to uncompress and save it on the 
hard disk (see page 16). 
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Tvpes of Files (Compressed. etc.) 

FTP files are mostly 3 types: 

l text files 
these are uncompressed and ready to read 

l uncompressed program files that are ready to run 
These programs are often self-extracting compressed files, just double click on them. 

l compressed files (including programs) 
Each computer platform may have its own compression program, so you will have to 
download the compressed file that your platform has the uncompress program for. 

- Macintosh files are mostly compressed with Stuffit Expander 
with a .Sit or .HQX extension. 
Ma&zip program claims to do gzip UNIX compression and decompression of files. 

- W indows files are mostly compressed with PKZIP with a .ZIP extension. 
Use the program PKUNZIP to uncompress the files. 

- UNIX files are mostly compressed with the compress program with .Z extension or 
the pack program with a similar .z extension. 
Uncompress with the uncompress or unpack commands. 

Caution: The only way to get a computer virus from using the Internet is by running an infected 
computer program. In transferring programs (not simple text files) via FTP, it is best to run the 
virus checker on all programs after you decompress it, and before you run it. 

Bow Netscaue does FTP 
The Netscape Navigator automatically communicates in the FTP protocol, so when it encounters an 
anonymous FIP site, it knows how to connect, log in anonymously, read the contents of the site, 
make requests for files, and transfer them. While Mosaic cannot do this, all Netscape needs 
from you are a couple of mouse clicks to get things going. 

What is a protocol? 
FIP refers to both a program and the protocol the FIP program uses to communicate from one 
computer to another. A Protocol is a language that a program uses to communicate to another 
copy of itself running elsewhere. Example: The Netscape Navigator and the source of a Web page 
communicate to each other using the protocol http, the hypertext transport protocol. Similarly, 
Netscape communicates like an FTP program to other FTP programs using the FI’P protocol. 

Anonvmous FTP 
Collections of files are stored in electronic libraries called anonymous FTP sites, and it’s from 
these ‘file libraries’ that Netscape can ‘check out’ copies of files. Anonymous FTP lets any user 
‘anonymously’ hop into an FTP site without a specific login name of password, and take copies of 
whatever files are there. (Actually, the login name is ‘anonymous’ and the password is your e- 
mail address, but programs like the Netscape Navigator take care of these automatically.) The 
mainframe is secure from intruders because anonymous PTP does not allow users with the 
“anonymous” login to delete or add files. 
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FTP with Fetch 
-the preferred method for bigger files with the Macintosh 

The program, Fetch, is much better suited for transferring files via FTP with the Macintosh. It can 
be used for 

1) anonymous FTP 
2) FTP using accounts and passwords 

-this allows writing files onto the server using an account with write privileges. 

Jnstallirw Fetch 

For SLAC Macintosh users the Fetch program is available over AppleShare: 
-from the Chooser, go to AppleTalk, zone Mac Servers, 
-get Public Server, Public Disk 1, 
-folder Things You Need, folder Internet Tools, folder Fetch 

For non-SLAC Macintosh users, Fetch should be on the Public Disk for your sites. If not, it is 
available on server pepii-server.slac.stanford.edu. 

Please e-mail ACHAN@SLAC.Stanford.EDU if you have problems. 

Usine Fetch 

To do anonymous FTP with Fetch, type in the dialog window when you start up Fetch 

Host: pepii-server.slac.stanford.edu 
User ID: anonymous 
Password: (you can leave black or type in your e-mail address) 
Directory (you can leave blank to start from root directory of the server) 

Double click on the folder icons to navigate up and down the directories or use the Directory option 
under menu Directory. 

Selected the file you want to FTP 

Choose file type Automatic for most files, 
Choose file type Text if you are transferring simple text files, 
Choose file type MacBinary if you are transferring files created by Macintosh programs (Word, 
Excel, etc.). These files will be transferred by Fetch with their proper Macintosh icons. 

Click on the button Get File and save the file onto your hard disk. 
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Fetch II 
Enter host name, user name, and password 
(or chooeo from fho ehortcut menu): 

Host: Ipepii-seruer.slac.stanford.edlJ(1 

User ID: anonymous 

Password: 

Directory: 1 

Shortcuts: 

Logging into anonymous FTP with Fetch 

r 
$ File Edit Remote Directories Customize LUin 

Fetch 
Fetch: pepii-seruer.slac.stanford.edu 

Copyright @ 1992 
Trustees of Dartmouth College 

piiizsi 

El 
CI BaBar Server 
0 Backups 
D Injection 

% 

Lattice 
MagBackup 

D Meeting MakerR XP 
D PEP-II Server 
m Public 

- 

May 6 20 :33 
Apr 5 15:54 
Sep 26 14 :52 
Jun 10 12:14 
Jun 18 16:58 
May 24 17 :05 
May 6 20 :33 
Jun 28 16 :26 

1 Put File... 1 

1 Get File... 1 

@ Automatic 
0 Text 
0 Binary 

l Navigating the server file directories with Fetch. 
l Use the Get File button retrieves files from the server to your 

Macintosh. 
l Use the Put File button to write files from your Macintosh to the 

server (needs password). 
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htalling NetscaDe 

For SLAC Macintosh Users 

The Netscape program is available over AppleShare: 
- from the Chooser, go to AppleTalk, zone Mac Servers, 
- get Public Server, Public Disk 1, 
- folder Internet Tools, folder W W W  Browsers, folder Netscape 
- copy the Netscape folder onto your hard disk 
- double click on the Netscape Installer 
- after you have successfully installed Netscape, erase the Netscape Installer 

(as well as old copies of the Netscape program you may have) 
- read the documentation in the Netscape folder to configure Netscape 

For more information, please read the ‘Netscape Installation & Config’ document on the SLAC 
Public Disk. 

For Non-SLAC Macintosh Users 

Please check with your Macintosh Administrators to access the Netscape Installer at your site, or 
some other Web Browsers like Mosaic or MacWeb. 

Please e-mail ACHAN @  SLAC.Stanford.EDU if you have problems. 

For Home Access via the Macintosh 

You need the following list of software installed on your home Macintosh: 

1) Netscape 
2) MacTCP (version 2.0.4 or later) 
3) AppleShare (version compatible with MacTCP 2.0.4) 
4) Apple Remote Access 

Please e-mail ACHAN@SLAC.Stanford.EDU if you have problems. 

Additional Software for the Macintosh 

The standard decompression program is Stuffit Expander (for SLAC users this is available on 
the Public Disk, for non-SLAC users please check with your Macintosh Administrators). 

MacGzip program is available on the Public Disk for SLAC users. 

MacGhostScript program is also available for a postscript viewer on the Macintosh 
(please e-mail ACHAN @SLAC.Stanford.EDU if you would like to test this program). 

For more information, please read the ‘Netscape Installation & Config’ document on the SLAC 
Public Disk. 
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For IBM-PC Users 

Please check with your IBM-PC Administrators to access the Netscape Installer at your site, or 
some other Web Browsers like Mosaic. The 32 bit version of Netscape is for Windows95 or 
Windows NT, the 16 bit version of Netscape is for earlier Windows versions. 

For IBM-PC’s, the standard compression and decompression program is PKZIP. 

Please e-mail ACHAN@SLAC.Stanford.EDU if you have problems. 

For UNIX Users 

If Netscape is already installed, type netscape at the UNIX prompt or from an XTerm window to 
start Netscape. 
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Configuring Netscape 

This section is oriented towards the Macintosh version of Netscape. The IBM-PC version will 
have some similarities. 

preference Dialog Box 

From the Options menu, choose Preferences. 

The Preference Dialog Box will show up. Netscape is configured from this dialog box. 
We outline here 4 essential settings in Preferences (Window and Link Styles, Mail and News, 
Applications and Directories, Helper Applications). For information on other settings, please refer 
to the ‘Netscape Installation & Config’ document on SLAC Macintosh Public Disk or the relevant 
document for your site. Additional information can be gotten from sources cited in the References 
section. 

f, W ’indow and Link Stvles 

l You set the page you want Netscape to start up with in the Home Page Location box. 
l Clicking on ‘OK’ will save your Preferences changes and quit this dialog box. 

r 
& File Edit Uiew Go Bookmarks Options Directory Help 

Preferences --.--_. 

1 W indow end link Stules 4 

I....Yindors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ......................................................... . ......................... 

Show Toolbar as: 0 Pictures 0 Text @Pictures and text 

Start with: 0 Blank Page 

@  Home Page LOCatiOn: http:~/www.slac.stanford.edu~acosl/pQpii/db.html 1 

,....Link Styles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ......................... I ............. 

Underline links 

Followed Links Expire: @  After II] days 0 Never 

; . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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3, Mail and News 

Your e-mail address and related information is used by Netscape for many transactions, including: 
- anonymous FTP 
- sending out e-mail 
- filling out forms 

You specify the settings in this window. 

l For SLAC users, in the Mail (SMTP) Server box, enter smtpserv.slac.stanford.edu 
after erasing the old text in the box. For non-SLAC users, please check with your system 
administrators. 

l In the Your Name box, enter your favorite name ! In the Your Email box, enter your 
electronic mail address (e.g. xyz@slac.stanford.edu). In the Organization box, enter SLAC 
or your home institution. You can leave the default values for the rest of the Mail settings. 

l For SLAC users, in the News (NNTP) Server box, enter nntp.slac.stanford.edu after 
erasing the old text in the box. You can leave the default values for the rest of the News settings. 
For non-SLAC users, please check with your system administrators. 

l Clicking on ‘OK’ will save your Preferences changes and quit this window. 

r 
6 File Edit Uiew Go Bookmarks Options Directory Help 

1 Mail and News 4 

,.... Mail . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ..“..................................................................................................................................................................................... 

Mail (SMTP) Server : smtpserv.slac.stanford.edu I 

Your Name : IAndrea Chan 

Your Email : ACH ANQSL AC .Stanford .EDU 

Organization : SLAd j4 

Signature File : 0 None 

0 l file: 

Send and Post : @  Allow 8-bit 0 MIME Compliant (Quoted Printable) 

I....Nevs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . * . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .I. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . \ 

NQWS (NNTP) Server : nntp.slac.stanford.edu 1 
i Maximum number of articles to show : 100 1 
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. 

3, ADolications & Directories 

l For SLAC users, you can leave the default values for the Supporting Applications settings. 
l In Directories, set the Temporary Directory to a folder you want files downloaded from 

Netscape to go to. In this example, I have created a folder named Web Download. Click on the 
Browse... button next to Temporary Directory. A navigation dialog box will pop up, and you 
need to navigate to the folder you want and click once to select it. For this example, click on the 
Select Web Download button that appears under the scrolling list. 

l Click now on ‘OK’ to leave the Preferences setup. 

r 
& File Edit Uiew Go Bookmarks Options Directory Help 

-_.-I__. Preferences --- __ ..- - _.-.-. _----- ^_ __.. 

1 Applications and Directories ‘I 

f . . . . Supporting Applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .................................................. 

Telnet Application: [jiizz] 

i TN3270 Application: Sin Frontera:Applications:tn3270 v 2.4a4 (ELZJ 

View Source: Sin Frontera:Applications:SimpleText [ Brorse... ] 

r....Directo+ies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . * . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ..I....................................... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . , 

I Temporary Directory: Macintosh HD:NetScape:Web Downloads 

i . . . 

4) Helter ADDlications 

Netscape is designed to use Helper Applications to view different multimedia files you retrieve. 
There are several Helper Applications available on the SLAC Macintosh Public Disk. 

Program Handle Multimedia 
File TvDe 

Handle 
File Extensions 

JPEGView 
Sparkle 
Sound Machine 
Adobe Acrobat Reader 

images tiff, jpeg, gif 
MPEG movies mpeg 
sounds aif, au, aiff, snd 
pdf files 
(written by Adobe Acrobat) 

MacGhostScript postscript 
(this is still a test version, see page 14) 

Ps 
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The Helper Applications dialog box tells Netscape you have these Helper Applications. It 

1) identifies the different file types Netscape encounters on the Web by associating a file type with 
a file extension 

2) tells Netscape the correct Helper Application to pass the file to after it identifies the file 

r 
& File Edit Uiew Go Bookmarks Options Directoru HeID __ 

L Preferences ---... 

Helper Applications 

applicationlootet-stream @  
4 SimpleText Launch exe ,.............. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .............................................................................. . ...... ... 

application/postscript a ‘- Mac GS Viewer PPC Launch ai,eps,ps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . , . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

1 application/rtf Microsoft Word Launch rtf 

Mime type: [applicatiorl] Subtype: x-macbinary 1 

Extensions: bin I 

Application: Mac BinaryII+ 

Action: 0 Save 

[y) File type: -1 

. @  Launch Application 

Specifying the name of the Helper Applications 

l Select the file type a Helper Application views from the Mime type and Subtype scroll list. 
(Mime refers to the method of determining a file type from a file’s extension.) 
Here the example is given for MacBinary program which is Mime type: application 

Subtype: x-macbinary 
Extensions: bin 

(Mime type is the general category of the file - text, image, video, audio, application. 
Subtypes are the names of the file formats. Examples of file extensions are on page 18) 

l Specify the file type’s Helper Application by clicking on the Browse... button and selecting 
the Helper Application to be run from the dialog box. 

l Select the Action to be performed when Netscape encounters this file type. 
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Adding or changing file extensions 

l Select the file type from the Mime type list. Add the new extension after the existing 
extensions in the Extensions field (separate the extensions with a comma). 

Adding a new file type to the Mime list 

l Click the New button to get the Create New Mime Type dialog box. 
Type in the new Mime Type and Mime subtype. 
Refer to the previous example on page 19. 

l Select the Action to be performed when Netscape encounters this file type. 

---------------------------------------------------------- 

References 

. ‘Using Netscape-The User-Friendly Reference’ 
by Warren Ernst from QUE publications is and excellent guide. 

. ‘The Netscape Online Handbook’ is on-line help you can access on WWW 
http://home.netscape.com/eng/mozilia/l.l/handbook/ 

0 ‘Netscape Installation & Config’ document on the SLAC Macintosh Public Disk. 

. ‘HTML Sourcebook-A Complete Guide to HTML’ 
by Ian S. Graham from John Wiley & Sons, Inc. publications is a good guide for the 
Hypertext Markup Language, creating Home Pages, Common Gateway Interface (CGI 
scripts), etc. 

Please contact the SLAC Computer Center Help Desk (415-926-2406, e-mail 
SERVDESK@SLAC.Stanford.EDU) or your local computer system administrators for help in 
using Netscape and other Web Browers. Please e-mail ACHAN@SLAC.Stanford.EDU for 
questions regarding this short guide. 
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